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ABSTRACT

Urban sprawl is a significant challenge facing rapidly growing cities, particularly in developing
countries, where unplanned expansion can strain infrastructure, degrade the environment, and
complicate land-use management. This study evaluates the urban sprawl of Oredo Local
Government Area (LGA), Edo State, Nigeria, using geospatial techniques to understand the patterns,
extent, and implications of urban growth from 2004 to 2024. Multi-temporal Landsat satellite images
were analyzed using Geographic Information Systems (GIS) to map land use and land cover (LULC)

changes, while population data were projected to assess growth and density patterns.

The analysis revealed substantial transformations within Oredo LGA over the twenty-year period.
Built-up areas expanded consistently, particularly between 2014 and 2024, often replacing
vegetation and bare land. Vegetation cover declined steadily, while water bodies and open land
diminished, reflecting environmental pressures associated with urban expansion. Population density
increased sharply from approximately 1,504 persons per square kilometer in 2006 to about 2,488
persons per square kilometer in 2024, highlighting the strong correlation between demographic
growth and land-use change. Areas such as Ring Road, Ugbowo, and Sapele Road were identified as
high-intensity development zones, whereas peripheral neighborhoods exhibited lower levels of

urbanization.

The study demonstrates that integrating remote sensing and GIS provides a robust framework for
monitoring spatial development, identifying hotspots of urban growth, and supporting evidence-
based urban planning. Based on the findings, recommendations include the institutionalization of
geospatial monitoring, development of a GIS-based land information system, preservation of green
spaces, targeted management of high-density zones, predictive modeling for future urban growth,
integration of geospatial data into planning policies, and capacity building for planners and

community engagement initiatives.



Overall, this research provides a data-driven foundation for sustainable urban planning in Oredo
LGA, emphasizing the need for proactive strategies that balance urban growth with environmental

conservation and efficient land-use management.
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CHAPTER ONE
INTRODUCTION

1.0 Background of the Study

Urban sprawl has emerged as one of the most pressing challenges in contemporary urban
development, particularly in rapidly growing cities in developing countries. It refers to the
unplanned or poorly managed expansion of urban areas into surrounding rural and peri-urban
lands, resulting in scattered settlements, low-density housing, and inefficient land use (Seto,
Fragkias, Guneralp, & Reilly, 2011). Urban sprawl often strains infrastructure, increases
commuting times, reduces green spaces, and contributes to environmental degradation. In the
Nigerian context, rapid urban growth is driven by population increase, rural-to-urban
migration, economic opportunities, and infrastructural development. Cities such as Lagos,
Abuja, and Benin have experienced significant spatial expansion over the past decades,

reflecting a broader trend of urbanization in the country (Adelekan, 2016).

Oredo Local Government Area (LGA), located within Edo State, encompasses Benin City,
one of Nigeria’s historical and administrative urban centers. This rapid urbanization poses
challenges such as traffic congestion, inadequate housing, pressure on public utilities, and
environmental degradation. Understanding the spatial dynamics of urban growth in Oredo
LGA is therefore essential for informed urban planning, sustainable land use management,

and effective policy formulation (Onokerhoraye, 2003).

Urban sprawl is influenced by multiple factors, including population growth, economic
development, availability of land, transportation networks, and policy frameworks.
Population growth in Oredo LGA has been significant; the 2006 census recorded a population
of approximately 374,500 people, which has since increased due to natural growth and

migration. The expansion of urban areas often occurs faster than the provision of



infrastructure, leading to challenges in service delivery and environmental management. By
analyzing the spatial extent and pattern of urban sprawl, planners can identify areas of rapid
development, understand the factors driving expansion, and implement strategies to manage

growth sustainably.

Geospatial techniques have transformed the study of urban growth by providing tools to map,
monitor, and analyze land-use changes across space and time. Geographic Information
Systems (GIS) and remote sensing enable planners and researchers to visualize current land-
use patterns, detect changes over time, and predict future urban growth trends. Multi-
temporal satellite imagery allows for the classification of LULC into categories such as built-
up areas, vegetation, water bodies, and barren land. By combining this information with
population data, infrastructure maps, and other socio-economic indicators, it is possible to
assess the intensity of urban development, identify hotspots of growth, and evaluate the

relationship between population dynamics and land use (Weng, 2007).

The use of GIS and remote sensing in urban studies is particularly important in Nigeria,
where rapid urbanization often outpaces the collection of ground-based data. These
techniques offer a cost-effective and efficient approach for monitoring urban expansion,
especially in fast-growing areas like Oredo LGA. Studies in other Nigerian cities have
demonstrated the value of geospatial techniques in understanding urban sprawl, identifying
land-use transitions, and supporting urban planning decisions (Adelekan, 2016; Awadh &
Ismail, 2015). Despite this, there has been limited research focusing specifically on Oredo
LGA, creating a need for spatially explicit studies that quantify the extent, pattern, and

intensity of urban sprawl over time.



1.1 Statement of the Problem

Oredo Local Government Area (LGA), which includes Benin City, Ogbe, the Government
Reservation Area (GRA), Etete, Iyekogba, Uzebu, Urubi, Oliha, Ukhegie, Iyaro, New Benin I
and II, Unueru, and Ugboka, had an estimated population of approximately 536,800 as of the
2006 census. With a projected annual growth rate of 2.8%, the region has witnessed rapid
urban expansion. This growth, driven by increasing population, economic activities, and
rural-to-urban migration, has placed immense pressure on the area's limited land resources

and created significant urban planning challenges.

Despite these expansions, there has been an evident lack of adequate planning and regulatory
control. One of the most pressing issues in Oredo LGA is the emergence of unplanned
settlements and poorly managed land use. The pace of urban growth has far exceeded the
capacity of official land-use planning. In line with national trends where nearly 45% of
Nigeria’s urban population resides in informal settlements many residential zones in Oredo
have developed organically without formal zoning, infrastructure, or services. This has
resulted in disorganized land-use patterns, where residential buildings, shops, and small-scale

industries operate side by side along narrow, congested streets.

A critical factor contributing to these challenges is the lack of accurate, up-to-date spatial
data. Planning authorities in Oredo LGA often rely on outdated maps, inconsistent land
records, and limited geographic information, which impedes effective monitoring of land-use
changes and enforcement of development control measures. Consequently, urban sprawl has
expanded unchecked, creating difficulties in infrastructure provision, environmental

management, and sustainable development planning.

Although the problems associated with urban sprawl are evident, there is limited application

of modern geospatial techniques, such as Geographic Information Systems (GIS) and remote
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sensing, to analyze and manage urban growth in Oredo LGA. Existing urban planning efforts
primarily rely on traditional, manual methods that are inadequate for capturing the spatial
dynamics of urban expansion. There is a clear need for studies that use geospatial
technologies to quantify the extent, pattern, and intensity of urban sprawl and to provide
actionable insights for sustainable urban management. Therefore, this study seeks to address
this gap by evaluating the urban sprawl of Oredo LGA from 2004 to 2024 using geospatial
techniques. It aims to provide an accurate, spatially explicit understanding of land-use
changes, population pressure, and development intensity to support effective planning and

promote sustainable urban growth in the LGA.

1.2 Aim and Objectives

To assess the spatial extent and pattern of urban sprawl in Oredo Local Government Area

using geospatial techniques. The objectives are to:

i.  analyze current land use patterns and urban growth trends in Oredo LGA from 2004
to 2024 using satellite imagery and GIS analysis;
ii.  evaluate population density and growth patterns as they affect land use;

iii.  identify areas where development are low, moderate and high within the study area;

1.3 Scope and Limitation of the Study

The scope of this study includes analyzing current land use patterns and urban growth trends
in Oredo Local Government Area, located in Edo state, Nigeria using Landsat satellite
imagery and geospatial tools. The temporal extent of the study spans a twenty-year period
from 2004 to 2024, which is essential for capturing significant phases of land use
transformation and urban expansion. Remotely sensed satellite data for these years will be
sourced from the United States Geological Survey (USGS) EarthExplorer platform

https://earthexplorer.usgs.gov/. Additionally, population data will be extracted from the



https://earthexplorer.usgs.gov/

WorldPop database (https://www.worldpop.org) to examine how demographic distribution

influences land use patterns. Areas of low, moderate, and high levels of development will be
identified. Microsoft Excel will be used for tabulation, statistical computations, and trend
analysis of urban growth and population density. Secondary data will also be obtained from
local authorities and relevant planning agencies to serve as a basis for validating the remote
sensing results. Ultimately, the study aims to provide recommendations for sustainable urban

development strategies based on geospatial analysis.

However, it is crucial to acknowledge potential limitations in the implementation of this
project. Limitations such as the spatial resolution of the Landsat imagery used, which is 30
meters. This moderate resolution may not capture small-scale changes or features, especially
in densely populated or informal urban areas, thus affecting the precision of land cover
classification. Cloud cover also affect the availability of clear satellite images, especially
during the rainy season. Population data from WorldPop are modeled estimates and may not
fully represent actual figures. Additionally, the lack of recent ground truth data reduced the

ability to validate classification results accurately.

1.4 Justification of the Study

This study will significantly benefit Oredo Local Government Area in Edo State, Nigeria, by
showcasing how Geospatial techniques can be effectively applied to assess and manage urban
sprawl. By addressing the limitations of conventional urban planning methods, GIS and
remote sensing offer up-to-date, accurate insights into land-use changes, population
distribution, and development patterns. A geospatial approach enables the creation of a
dynamic land information system that can be continuously updated, allowing planners and
policymakers to map current urban conditions, identify areas of rapid expansion, and simulate

future urban growth scenarios for sustainable development.
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This study supports broader sustainable development goals by promoting transparent,
efficient, and proactive urban governance in Oredo Local Government Area. The
expected outcome is to generate actionable insights and recommendations that will guide
policymakers in making informed, strategic decisions for urban planning. Moreover, the
study will highlight the practical value of geospatial techniques in monitoring, analyzing,
and managing urban sprawl, demonstrating their importance as a modern tool for

sustainable urban management.



CHAPTER TWO
LITERATURE REVIEW

2.1 Concentric Zone Theory

The Concentric Zone Theory, developed by Burgess (1925), posits that cities grow outward
in a series of concentric rings from a central business district (CBD). Each ring is associated
with specific land-use patterns: the innermost zone typically consists of the CBD and
commercial activities; the next zone includes transitional areas with mixed uses; followed by
residential zones of varying densities; and the outermost zones contain low-density

residential areas, industrial estates, and peri-urban settlements.

This model is particularly relevant to the study of urban sprawl in Oredo LGA, as it provides
a conceptual framework for analyzing how land use has expanded from the historical center
of Benin City to peripheral communities. The theory helps explain why areas closer to the
city center are densely developed, while outskirts such as Uzebu, Urubi, and Unueru exhibit
low-density, scattered settlements that are characteristic of urban sprawl. Understanding these
spatial patterns allows planners to identify zones of intense development and areas at risk of

uncontrolled expansion.

2.2 Urban Sprawl Theory

Urban sprawl theory emphasizes the patterns, causes, and consequences of unplanned urban
expansion. It identifies factors such as population growth, migration, transportation networks,
economic incentives, and weak governance as key drivers of sprawl (Ewing, 1997).
According to the theory, sprawl manifests as low-density development, fragmented land use,

and a lack of coordinated infrastructure planning.

In Oredo LGA, urban sprawl is evident in the proliferation of informal settlements, irregular

residential patterns, and mixed land uses that occur without proper planning or zoning
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regulations. The theory highlights that unchecked expansion leads to inefficiencies in
infrastructure delivery, environmental degradation, and increased socio-economic disparities.
By framing the study within urban sprawl theory, it becomes possible to analyze not only the
spatial extent of growth but also the socio-economic and environmental implications of

unplanned development.

2.3 Land-Use Change and Spatial Analysis Models

Land-use change models provide a theoretical basis for understanding how human activities
transform natural and rural landscapes into urban settlements over time. These models
recognize that urban growth is influenced by complex interactions between population
dynamics, economic activities, environmental conditions, and policy frameworks (Lambin &

Geist, 2000).

Geospatial techniques, such as Geographic Information Systems (GIS) and remote sensing,
are grounded in these models. They allow researchers to quantify and visualize land-use
changes, detect emerging patterns, and predict future urban growth scenarios. For instance, in
Oredo LGA, satellite imagery can be used to classify land into various classes over multiple
years, providing a temporal and spatial understanding of urban sprawl. The integration of
land-use change theory with geospatial tools supports evidence-based urban planning by

linking observed spatial patterns to underlying socio-economic drivers.

2.4 Concept of Urban Sprawl

Ewing (1997) defines urban sprawl as “unplanned, uneven, and low-density development
extending outward from urban centers, typically accompanied by automobile dependence and

fragmented land-use patterns.”



Galster et al. (2001) describe urban sprawl as “a pattern of land use in an urban area that

exhibits low levels of density, continuity, concentration, centrality, and proximity.”

Brueckner (2000) defines the phenomenon as “excessive spatial growth of cities resulting

from demographic and economic forces and leading to inefficient land consumption.”

According to the OECD (2018), urban sprawl refers to “the dispersed, low-density, and

uncoordinated expansion of urban areas.”

UN-Habitat (2014) defines urban sprawl in African cities as “the outward expansion of urban
areas dominated by informal settlements, inadequate infrastructure, and weak planning

controls.”

Kombe (2005) describes it as “the unplanned and uncontrolled expansion of urban land uses
into peri-urban areas, typically driven by informal land markets and deficient development

regulation.”

Oyeleye (2013) refers to urban sprawl as “the disorderly and uncoordinated outward
expansion of built-up areas into peripheral zones, largely influenced by population growth

and weak enforcement of planning regulations.”

Akinyemi and Qlomo (2016) describe it as “rapid outward spread of urban development
characterized by informal housing, mixed land uses, and inadequate development control

mechanisms.”

Fabiyi (2006) states that urban sprawl in Nigeria is “the spontaneous conversion of
agricultural and forest lands into residential and commercial uses, typically occurring ahead

of formal planning processes.”



2.5 Urbanization and Its Drivers

Urbanization refers to the increasing concentration of people within urban areas, resulting
from demographic, social, economic, and environmental transformations occurring over time.
It is a multifaceted process shaped by the interplay of natural population growth, migration,
economic restructuring, and policy dynamics. Globally, urbanization has accelerated over the
past century, with developing regions especially Africa and Asia experiencing the fastest
growth rates. This phenomenon has been linked to the search for improved livelihoods,

enhanced access to social services, and the perceived opportunities that cities offer.

One of the fundamental drivers of urbanization is natural population increase, where birth
rates remain higher than death rates in many developing countries. As healthcare improves
and mortality rates decline, urban areas continue to swell, putting pressure on infrastructure
and land resources. Another significant driver is rural-to-urban migration, motivated by
economic disparities between rural and urban areas. In many countries, agricultural
stagnation, climate-induced land degradation, and limited employment opportunities in rural
settings compel individuals to move to cities, where industrial growth, commercial activities,

and service-oriented employment appear more promising.

Urbanization is also driven by economic transformation, particularly the growth of
manufacturing, trade, and service sectors. Cities serve as hubs of innovation, investment, and
industrial expansion; thus, they attract both skilled and unskilled labor seeking better
economic prospects. As urban economies diversify and integrate into global markets, they
continue to pull populations from surrounding regions, further increasing their spatial

footprint.

In addition, infrastructural development such as transportation networks, educational

institutions, and healthcare facilities plays a crucial role in attracting populations to urban
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centers. The concentration of these amenities creates a gravitational pull that reinforces
migration flows. Likewise, government policies and administrative functions, including the
presence of political headquarters, stimulate urban growth by clustering public institutions,

bureaucratic offices, and complementary services within specific localities.

In the African context, urbanization has also been strongly influenced by historical and
colonial legacies, which structured economic activities and transportation routes around
administrative capitals and resource-rich areas. As a result, post-colonial cities have
continued to expand rapidly, often without corresponding improvements in planning
frameworks or land management systems. Nigeria exemplifies this trend, with cities like
Lagos, Abuja, and Benin City experiencing sustained growth driven by population increase,
commercial expansion, and migration from rural regions seeking better socioeconomic

opportunities.

Overall, urbanization is a product of multiple intertwined forces demographic, economic,
political, and environmental. These drivers collectively reshape spatial patterns and exert
pressure on land resources, ultimately contributing to the emergence and intensification of
urban sprawl, particularly in rapidly growing regions such as Oredo Local Government Area

in Edo State.

2.6 Application of Geospatial Techniques in Urban Studies in Nigeria

Galster et al. (2001) investigated the spatial dimensions of urban sprawl, identifying density,
continuity, concentration, centrality, clustering, and proximity as key measures. Using a
combination of geospatial metrics and demographic analysis, their study revealed that
dispersed development patterns undermine efficient land use and strain urban infrastructure
they emphasized the need for strategic urban planning that promotes compact, well-connected,

and socially integrated urban forms.
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Schneider and Woodcock (2008) applied Landsat satellite imagery to assess urban expansion
in 25 large cities worldwide. Their findings indicated that rapid, unplanned growth
contributes to significant land consumption, environmental degradation, and the loss of
natural habitats. By integrating remote sensing and GIS, the study highlighted the importance

of geospatial monitoring for effective urban management and proactive policy interventions.

Batty (2008) explored urban growth using spatial modeling and fractal theory to understand
the patterns of city expansion. His research demonstrated that urban sprawl follows
predictable spatial patterns, which can be simulated and analyzed using GIS tools. Batty
recommended that planners use geospatial modeling to anticipate future growth, optimize
land allocation, and minimize the environmental and infrastructural impacts of sprawling

development.

Seto et al. (2010) conducted a global assessment of urban land expansion across 326
metropolitan areas using satellite imagery. Their findings revealed rapid, outward city growth,
often exceeding local planning capacities and leading to environmental degradation. The
study emphasized the importance of integrating remote sensing and GIS for monitoring urban

expansion, planning infrastructure, and guiding sustainable land-use policies.

Kombe (2005) analyzed the growth of informal settlements and urban sprawl in Dar es
Salaam, Tanzania, using spatial analysis and remote sensing data. The study revealed that
rapid population growth, weak planning enforcement, and unregulated land markets
contributed to fragmented, low-density development along the city’s peripheries. Kombe
recommended strengthening urban planning frameworks, integrating geospatial monitoring,

and improving infrastructure provision to manage expansion sustainably.
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Awadh and Ismail (2015) investigated urban expansion in Accra, Ghana, applying GIS and
multi-temporal satellite imagery to assess land-use changes. Their findings showed
significant outward growth, with peri-urban areas absorbing much of the population due to
high housing demand and weak regulatory controls. The study emphasized the role of
geospatial techniques in identifying development hotspots and recommended using GIS-
based planning tools to guide infrastructure investment and control informal settlement

growth.

Akinmoladun et al. (2014) assessed urban growth patterns in southwestern Nigeria using
GIS-based classification techniques. Their research revealed that sprawling residential
settlements are encroaching on environmentally sensitive areas, often with inadequate
infrastructure. The study suggested the adoption of comprehensive spatial monitoring,
enforcement of land-use regulations, and proactive urban planning strategies to manage urban

expansion effectively.

Adelekan (2016) investigated urban growth in Lagos, Nigeria, through satellite imagery and
GIS analysis, highlighting the environmental and social consequences of rapid sprawl. The
study showed that uncontrolled horizontal expansion leads to loss of green spaces, increased
flood risk, and traffic congestion. Adelekan recommended integrating geospatial monitoring
with urban policy frameworks to facilitate sustainable land use and mitigate the adverse
effects of sprawl.

In a case study of Lagos, Nigeria, Adelekan (2010) examined urban sprawl using remote
sensing and GIS to track land-use changes over time. The study revealed that unplanned
settlements and low-density residential growth dominate the city’s outskirts, resulting in

fragmented urban landscapes and increasing pressure on infrastructure. Adelekan
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recommended integrating geospatial monitoring with urban planning policies to guide

sustainable development and reduce the adverse impacts of sprawl.

Akinmoladun et al. (2014) assessed the patterns of urban expansion in southwestern Nigeria,
focusing on the encroachment of residential areas into agricultural and environmentally
sensitive zones. Using GIS-based classification techniques, their study identified low-density,
dispersed growth as a major driver of urban sprawl. The authors suggested proactive land-use
planning, enforcement of zoning regulations, and geospatial tools for monitoring future urban

growth.

Awotona (2002) investigated urban growth and informal settlements in Nigerian cities,
highlighting the relationship between population increase, migration, and unregulated
development. His study showed that urban sprawl often results in inadequate infrastructure,
poor access to services, and environmental degradation. Awotona recommended systematic
urban planning, community-based interventions, and the use of GIS for effective spatial

monitoring and management of urban growth.

Olajuyigbe et al. (2017) focused on peri-urban expansion in Ibadan, Nigeria, using remote
sensing and GIS to analyze land-use changes. Their research revealed that rapid, unplanned
growth in the city’s outskirts leads to infrastructure deficits and conflicts over land use. The
study emphasized the importance of geospatial techniques in mapping and monitoring urban
expansion, and recommended evidence-based planning policies to ensure sustainable

development.

Okpala Rex et al. (2017) examined rapid urban expansion in Nyanya, Abuja, highlighting
how weak planning frameworks and unchecked population growth have caused

environmental degradation and infrastructural stress. Using both qualitative and quantitative
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methods, the study identified critical issues such as worsening air quality, inadequate roads,
and insufficient public amenities. The researchers recommended integrating modern planning
tools, coordinated infrastructure development, and proactive policy design to manage peri-

urban growth sustainably.

Odeyale (2018) explored the effects of unplanned urban sprawl on the spatial organization of
Nigerian cities. His research revealed that informal settlements house nearly 45% of the
population, disrupting urban structure and livability. Using spatial analysis of development
patterns and population distribution, Odeyale recommended robust urban design frameworks,
improved planning mechanisms, and the adoption of geospatial tools to guide sustainable

urban growth.

Imhonopi and Urim (2018) analyzed urban expansion in Benin City, Edo State, highlighting
the rapid growth of residential and commercial areas along the city outskirts. Using GIS and
satellite imagery, their study revealed that population growth, rural-to-urban migration, and
economic development are key drivers of urban sprawl in the region, the researchers
demonstrated how unplanned growth leads to congestion, fragmented land use, and
inadequate infrastructure. They recommended integrating geospatial monitoring into urban

planning and enforcing zoning regulations to manage future development sustainably.

Eweka and Omorodion (2015) examined land-use change in Benin City over a 15-year period,
emphasizing the conversion of agricultural and vacant lands into urban settlements. The study
used GIS mapping and remote sensing to quantify the rate and extent of urban sprawl their
findings showed that urban expansion in Oredo LGA has been largely unregulated, resulting
in irregular settlement patterns and environmental stress. They recommended that local
authorities adopt GIS-based planning systems and robust land-use policies to control
uncontrolled growth.
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Aghimien and Ogbebor (2019) investigated urban growth in Benin City using multi-temporal
satellite imagery to assess spatial patterns of expansion. The research highlighted that
informal settlements, low-density housing, and scattered development dominate the city’s
peripheries. The study emphasized the importance of geospatial techniques for mapping land-
use changes and recommended that urban planning authorities in Edo State use GIS and

remote sensing for evidence-based decisions to ensure sustainable development.

Omoike and Uyi (2017) focused on the impacts of rapid urbanization on the spatial
organization of Benin City. Using GIS-based spatial analysis, their study revealed that
population increase and commercial activities have accelerated the conversion of farmland
and open spaces into built-up areas, contributing to urban sprawl. The authors identified key
growth hotspots and recommended that urban planners adopt geospatial monitoring and

enforce development control policies to guide sustainable expansion.

Osakwe and Imasuen (2016) explored the relationship between urban growth and
infrastructure development in Oredo LGA, Benin City. The study used satellite imagery and
GIS to map urban expansion, their findings highlighted the challenges of managing rapid
horizontal expansion, including inadequate road networks, insufficient water supply, and
environmental degradation. They recommended adopting proactive land-use planning,
geospatial monitoring, and strategic infrastructure deployment to mitigate the negative effects

of urban sprawl.

2.7 Appraisal of the Reviewed Literature

The reviewed literature collectively underscores the critical role of geospatial techniques,
particularly Geographic Information Systems (GIS) and remote sensing, in the study and
management of urban sprawl. These technologies have proven essential for tracking urban

growth, mapping land-use changes, detecting informal or unauthorized developments, and
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projecting future expansion. When these findings are contextualized within Oredo Local
Government Area (LGA), Edo State, several important insights and a noticeable research gap

emerge, highlighting the need for a focused, localized study.

In Nigeria, GIS and remote sensing have been successfully applied in cities such as Lagos,
Ibadan, Kano, Jos, and Ibadan, addressing challenges ranging from unplanned settlements
and traffic congestion to environmental degradation and loss of agricultural land. These
studies demonstrate the versatility of geospatial tools in analyzing complex urban dynamics
and their potential relevance for understanding the patterns and drivers of urban sprawl in
Oredo LGA, where rapid population growth and economic activities have fueled unplanned

expansion.

Methodologically, the reviewed studies exhibit advanced analytical techniques, including
multi-temporal satellite image analysis, Cellular Automata—Markov Chain modeling, spatial
overlays, predictive simulations, and 3D GIS visualization. These approaches allow
researchers to quantify urban expansion rates, identify development hotspots, assess land-use
changes, and simulate potential future growth. Such methods are particularly applicable to
Oredo LGA, where accurate spatial data is needed to guide sustainable urban development

and support evidence-based decision-making.

The literature further reinforces the theoretical foundations of Remote Sensing and
Geospatial Theory. Remote sensing provides the capability to capture detailed, multispectral,
and time-series spatial data over large areas, while GIS enables storage, management,
analysis, and visualization of complex spatial relationships. Together, these tools offer a
robust framework for evaluating the spatial extent, intensity, and patterns of urban sprawl in

Oredo LGA, facilitating strategic urban planning and management interventions.
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Finally, the reviewed works provide actionable recommendations that are relevant to the

context of Oredo LGA. These include the enforcement of land-use regulations, strengthening

institutional capacity for urban management, adopting participatory planning approaches, and

integrating geospatial monitoring into urban policy frameworks. Such measures align with

the objectives of the present study, which seeks to evaluate urban sprawl using geospatial

techniques to inform sustainable planning, optimize land use, and mitigate the adverse

impacts of uncontrolled urban expansion in Oredo LGA.

2.8 Research Gap

An in-depth examination of current literature on urban planning with GIS uncovered key

research gaps:

1.

None of the existing studies directly examine specifically evaluate urban sprawl or apply
geospatial techniques within Oredo.. Although similar approaches have been used in
other Nigerian cities, the absence of localized research creates a significant empirical
void, limiting understanding of the unique spatial growth patterns, land-use dynamics,
and urban development challenges in the area.

Research efforts have largely focused on major metropolitan areas like Lagos, Abuja,
and Ibadan or on cities in the northern regions such as Kano, Gombe, and Jos. In contrast,
mid-sized urban centers like Benin City where Oredo is located remain underrepresented
in scholarly discourse, despite experiencing urban challenges including unplanned
settlements, flooding, inadequate infrastructure, and traffic congestion.

Additionally, there is a noticeable there is a notable scarcity of long-term studies using
satellite imagery to monitor urban expansion in the South-South geopolitical zone. Few

studies have employed historical and contemporary remote sensing data to quantify
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urban sprawl or project future development trends in Oredo, thereby limiting
opportunities for proactive spatial planning and sustainable land-use management.

4. While the broader literature highlights the effectiveness of GIS in aligning with urban
master plans and policy frameworks, there is little to no evidence of such integration in
Oredo. Many of the planning documents in the area are still in analog formats and lack
geospatial referencing, underscoring the need for digitization and the incorporation of
GIS-based tools into planning practice.

5. Moreover, although predictive spatial modeling techniques such as Cellular Automata
and Markov Chain simulations have been used in cities like Lagos and Oshogbo to
forecast urban expansion, these models have not yet been applied in Oredo. This absence
hinders the capacity of urban planners to anticipate future land demands, infrastructure
requirements, and environmental risks associated with urban sprawl.

6. Finally, while Remote Sensing and Geospatial Theory advocate for multi-scale,
interdisciplinary analysis, this approach has been scarcely implemented in Oredo. There
is minimal integration of datasets, including population statistics, land tenure records,
and infrastructure inventories, to conduct comprehensive spatial assessments across
sectors such as housing, transportation, and environmental management. This highlights
the pressing need for a holistic, data-driven framework that leverages geospatial

techniques to evaluate urban sprawl and guide sustainable urban planning in Oredo LGA.

These gaps were addressed by developing an operational framework for urban planning using

geospatial techniques.
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CHAPTER THREE
METHODOLOGY

3.1 THE STUDY AREA

Oredo Local Government Area (LGA) is one of the eighteen LGAs that make up Edo State,
located in the southern part of Nigeria. Geographically, it lies between latitudes 6°15'N and
6°30'N and longitudes 5°35'E and 5°45'E. It shares boundaries with Egor LGA to the north,
Ikpoba-Okha LGA to the east and south, and Uhunmwonde LGA to the west (Edo State

Government, 2021).

Covering roughly 249 square kilometers, Oredo is among the most urbanized and densely
populated LGAs in Edo State. The 2006 National Population Census recorded a population of
approximately 374,671, but current estimates suggest significant growth driven by rapid

urban expansion and migration (National Population Commission, 2006).

The LGA encompasses both urban and semi-urban areas, including notable locations such as
King’s Square (Ring Road), Ugbowo, Sakponba, New Benin, Government Reserved Area
(GRA), and parts of Ikpoba Hill. Land use in these districts is diverse, featuring residential,
commercial, industrial, and institutional zones. A major cultural landmark within Oredo is
the Palace of the Oba of Benin, which affirms its importance as a center of traditional

authority and cultural heritage.

Situated within the humid tropical climatic zone, the area experiences two distinct seasons:
the wet season from April to October and the dry season from November to March. Annual
rainfall ranges between 1,500 mm and 2,000 mm, while temperatures typically vary from
24°C to 32°C. Although the region was originally dominated by derived savannah vegetation,

extensive urbanization has replaced much of the natural landscape with built-up areas.
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Two notable rivers the Ikpoba and Ogba flow through Oredo, often contributing to seasonal
flooding during the rainy months. The LGA also hosts key institutions and landmarks such as

the Edo State Government House, the National Museum, and the University of Benin.

Prominent communities and districts in Oredo include Etete, GRA, Ibiwe, Ihogbe, Ugbague,
Iwegie, Ikpema, Oreoghene, Eguadase, New Benin I, New Benin II, Ogbe, Ogbelaka, and
Isekhere. These areas collectively showcase the LGA’s socio-cultural diversity and

underscore its role as a central urban hub in Edo State.
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Figure 3.1 map of study area
Source: https://open.africa/dataset/?tags=Nigeriat LGA+Boundaries
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3.2 Data Acquisition

The following secondary data were acquired for the study:

1. Landsat Satellite Images for the years 2004, 2014 and 2024; and

2. 2006 National Population Census for Oredo L.G.A.

Multi-temporal Landsat Satellite Imageries were downloaded to analyze the land use and
urban growth patterns over a 20-year period. The images were sourced from the United

States Geological Survey (USGS) Earth Explorer platform-https://earthexplorer.usgs.gov/.

Three images were downloaded; Landsat 5 for 2004, Landsat 8 for 2014 and Landsat 9 for
2024. The images were projected using the WGS 84 datum and UTM Zone 31N coordinate

system.

The Oredo L.G.A shapefile was converted to KMZ file using Google Earth. This file was
then uploaded to the USGS EarthExplorer platform under the search criteria. From the
available datasets, Landsat Collection 2 Level-2 was selected, with a specific focus on
Landsat 89 OLI/TIRS C2L2. The cloud cover threshold was set between 10-15%, and the
temporal range was defined from 01/01/2024 to 31/12/2024. Under additional criteria,
satellites 8 and 9 were specified. The search results were examined to identify footprints
covering the study area, after which the Level-2 surface reflectance bands were selected,
added to the bulk download, and processed through the item basket. The imagery was finally
ordered, downloaded via the bulk download application, and stored in a designated folder for

subsequent analysis.

The population data used for this study were derived from the 2006 National Population
Census for Oredo Local Government Area, conducted by the National Population

Commission (NPC) of Nigeria. The 2006 census provided the official population figure of
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374,500 persons for Oredo LGA, which served as the baseline for all subsequent projections

and density calculations.

3.3 Data Processing

The processing of the acquired data followed a step wise approach. For the Landsat Satellite
Imageries, the procedure involved pre-processing followed by image classification. In the
case of Population data density patterns for Oredo L.G.A., the processing sequence included

data preparation, projection and density computation.

3.4 Processing of the Landsat Satellite Images

The Landsat Satellite Imageries were processed in the following sequence.

3.5 Image Pre-Processing

The image pre-processing was done in the following sequence: Band composition and

Clipping Study Area

3.6 Band Composition

Band Composition process, known as Layer Stacking involves stacking spectral bands. The
individual spectral bands were first layer-stacked in ArcGIS using the Composite Bands tool.

The procedures were as follows:

i.  from the menu bar of ArcMap 10.7, select Windows;
ii.  under the Windows tab, click on Image Analysis to open the Image Analysis tools;
iii.  in the Image Analysis dialog box, highlight the various individual Landsat bands (e.g.,
Band 1, Band 2, Band 3, etc.), and then select the Composite Bands tool. This

generates a temporary false-color multiband raster layer;
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1v.

in the Display panel of the Image Analysis dialog box, adjust the brightness, contrast,
and transparency settings to enhance the visual quality of the composite image; and
assign an output filename and choose the output file format (e.g., .tif), then click on

Save to export the raster dataset to a specified directory or folder.

3.7 Clipping Study Area

This step was carried out to retain only the area of interest for subsequent classification and
analysis. It was achieved through the following procedures;

1.

ii.

iii.

importing the boundary shapefile of Oredo Local Government Area into the ArcGIS
environment using the Add Data button;

launching the extraction tool by navigating to Arc Tool box > Spatial Analyst Tools >
Extraction > Extract by Mask; and

in the Extract by Mask dialog box that appears, the layer-stacked multiband raster
dataset was entered into the Input raster field, the Oredo LGA boundary shapefile was
selected in the Input feature mask data field, the output filename and directory were
specified in the Output raster field, and the OK button was clicked to execute the

operation.

3.8 Image Classification

Image classification involved categorizing satellite images into different land cover types,

such as built-up areas, vegetation, water bodies, and bare land. The process Comprised

Supervised Classification using Training Sample Collection, followed by an Accuracy

Assessment.

3.9 Supervised Classification using Training Sample Collection

The Supervised Classification using Training Sample Collection was achieved by selecting

Training Sites using high-resolution Google Earth images. A minimum of four land use
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classes were defined: built-up area, vegetation, bare soil, and water bodies. Using the ArcGIS

Image

Classification toolbar, representative pixels was digitized into training samples for

each land use class. The processing involved:

ii.

iii.

1v.

Vi.

Vil.

loading of the layer-stacked composite image and any relevant reference data into the
ArcMap environment using the Add Data button;

opening the Image Classification toolbar by right-clicking in the toolbar area and
selecting Image Classification;

from the Image Classification toolbar, click on the Training Sample Manager icon to
open the training data interface;

use the Draw Polygon tool (located on the Image Classification toolbar) to manually
digitize training polygons over known land cover types such as built-up areas,
vegetation, bare land, and water. Each polygon represents a single class;

after drawing each polygon, assign a class name and, optionally, a color in the
Training Sample Manager to differentiate between land cover categories;

create multiple training polygons per class in different parts of the image to ensure
spatial and spectral variability is captured; and

once all training samples are created, click on the Save icon in the Training Sample
Manager to export the training data as a signature file (.gsg) or as a shapefile, which

will later be used in the classification process.

Post-Classification Processing: Post-processing techniques, including majority filtering and

boundary smoothing, was applied to remove isolated misclassified pixels and enhance map

readability.
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3.10 Accuracy Assessment

An accuracy assessment was conducted to evaluate the reliability of the classified land cover
maps. A confusion matrix was generated by collecting samples from the classified land cover
raster and comparing with ground data from Google Earth Pro. The overall accuracy,
producer’s accuracy, and user’s accuracy was calculated, along with the Kappa coefficient, to
measure the agreement between the classified image and the reference data using their

individual formulas.

A point shapefile was created and then used to pick several sample points on the classified
map after which “start editing” on the editor toolbar was selected. The point data that was
selected on the map was exported to a Kml file using Spatial analyst tool > conversion >
raster to KML. The kml file was opened using Google Earth and the time series icon was
used to navigate to year 2004 after which the points were corresponded and tabularized as

shown below for the year 2004. This process was repeated for year 2014, and 2024 as well.

The formulae for the User accuracy, Producer accuracy, overall accuracy and Kappa

Coefficient is stated thus:

User Accuracy = (Correctly classified pixels/Total pixels classified in that class) x 100%

Producer Accuracy = Number of correctly classified pixels in each category/Total number of

pixels in that category (The column total) x100%

Overall Accuracy = Total number of correctly classified pixels (Diagonal)/Total number of

reference pixelsx100%

Il
I
~N
|
I

Where:

Po - Observed accuracy (sum of diagonal elements + total reference pixels)
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Pe -Expected accuracy (sum of the products of the row and column totals for each class +

square of total reference pixels)

3.11 Processing of Population data for Oredo L.G.A.

The Classified Satellite Image Population Density Patterns for Oredo was processed

following these sequence:

1. Data preparation
ii.  Population Projection

iii.  Population Density Computation

3.12 Data Preparation

The 2006 baseline population figure of 374,500 persons for Oredo LGA was compiled and
verified from the National Population Commission records. The land area of 249 km? was
extracted from the administrative boundary shapefile using GIS tools to ensure accuracy in

subsequent density calculations.

3.13 Population Projection
Since there was no new census data after 2006, the population for 2014 and 2024 was

estimated using the exponential growth model:

= o0o@a+

Where:

= Projected population at time ¢

_0 = Base year population (2006)
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r = Annual population growth rate (2.8% or 0.028)

t = Number of years after the base year

3.14 Population Density Computation

The population density for each period was determined using the formula:

3.15 Data Analysis

The following analysis were conducted on the results obtained from the processed data

1. Change Detection Analysis.
2. Land Use Change Detection and Urban Growth Analysis.
3. Identification of Areas of Low, Moderate, and High development within the study

arca.

3.16 Change Detection analysis

The Post-classification comparison and Transition Matrix were used for the change detection

analysis.

3.17 Post-classification Comparison

Post-classification comparison is a change detection method that involves comparing
classified land use/land cover (LULC) maps from different years after they have been
individually classified. In this study, satellite images from 2004, 2014, and 2024 was each
independently classified into LULC categories (e.g., built-up, vegetation, bare land, water)
and percentage area changes were identified and quantified using GIS tools such as ArcGIS

The procedure for overlaying the images comprised the following:

1. Import the stacked raster data using the Add Data tool.
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ii.

iii.

1v.

Vi.

Vii.

Viii.

iX.

xi.

Xii.

Open ArcToolBox > Conversion Tools > From Raster > Raster to Polygon. Select the
raster data in the field provided and click ok after an output file has been specified.
Right click on the Polygon > Open attribute table.

Open Geoprocessing from the toolbar > Dissolve > Select the polygon as input and
specify and output class > Tick Gridcode and select ok.

Open the attribute table of the dissolved polygon and add two new fields. One for the
classes i.e. Vegetation, Bare land etc., and the other for the area of each class.

Right click the field for area of each class > Calculate Geometry > select the unit
preferred for calculation and click ok.

In the editor, start editing and then input each classes matched with the Id provided in
the attribute table.

The same was done for the second year of interest

Geoprocessing > Intersect > select the lower year and then the older year, specify an
output file and click ok.

Open the attribute table of the intersected polygon and add two new fields. One for
area change and the other for class change.

Right click the area change field > Calculate Geometry > select preferred unit for
calculation and click ok.

Right click the class change field > Field Calculator > Subtract the Lower year from

the Upper year and click ok.

Area change comparison was carried out by calculating the total area for each year along with

their corresponding percentages. The results were tabulated to illustrate land use for each

year as well as the progression over time. In addition, a graph was generated to provide a

visual representation of the decline or growth in land use/land cover across the years. The

steps involve:
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ii.

iii.

1v.

Open the dissolved polygon file in ArcGIS and open the attribute table

Copy the field that has the area of each class

Open an excel workbook and paste the copied data into the sheet

Do the same for other years v. Use the formula below to calculate the total area used

per year and the percentage for each class.

Where T= Percentage growth in LULC for a particular year

K= Actual area covered by an individual class in the specified year

N= Total area of the study area per year

3.18 Transition Matrix

A transition matrix also known as cross-tabulation matrix was used to quantify the amount

and type of change that occurred between different land use classes over time. For instance,

the matrix compares class "A" (e.g., vegetation) in 2004 with class "B" (e.g., built-up) in

2014 or 2024. Each cell in the matrix showed how much area transitioned from one class to

another (e.g., how many hectares of vegetation were converted to urban/built-up land) and

was visualized using maps and charts to highlight significant changes in land cover patterns.

This was achieved as follows:

1.

ii.

The contents of the intersected polygon attribute table was copied to an excel
spreadsheet.
In the tool bar > Insert > Pivot table. Input the upper year in the column, the lower

year in the row and the area change field in the Sum of Values and click ok.

30



3.19 Land Use Change Detection and Urban Growth Analysis

The results obtained from the post classification were used to generate charts and maps using
ArcGIS and Microsoft Excel for a visual representation of the changes in pre-defined classes.

These changes were analyzed to determine land use change and urban development.

3.20 Identification of Areas of Low, Moderate, and High development within the study
area

Following the analysis of land use and land cover (LULC) changes and the evaluation of
population density patterns in Oredo Local Government Area, This objective builds on the
findings from the first two analyses, linking spatial land cover transformations with
population growth trends to better understand the dynamics of urban expansion. The
identification was carried out through comparative interpretation of LULC classification

results for 2004, 2014, and 2024 alongside the projected population density data.

This analytical approach provided a practical means of assessing spatial development trends
using existing data outputs, ensuring consistency with the earlier objectives while offering a

clear understanding of how development varies across the study area.
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CHAPTER FOUR
PRESENTATION OF RESULTS

4.1 The result of urban sprawl from 2004-2024

The result of urban sprawl from 2004-2024 is presented in Figure 4.1.
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Figure 4.1 LULC map of Oredo 2004, 2014 and 2024

The Figure 4.1 shows the land use and land cover (LULC) maps of Oredo Local Government
Area for the years 2004, 2014, and 2024 clearly show how the landscape has changed over
the last two decades. The classification was grouped into four main categories built-up area,

barren land, vegetation, and waterways.

In 2004, vegetation was the most dominant land cover type within Oredo. This indicates that

most of the land was still covered by natural vegetation such as forests, farmlands, and
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grasslands. Built-up areas were very small and limited mainly to the northern tip of the map,
which represents the older, more established parts of Benin City. There were only a few
scattered areas of barren land, which could represent exposed soil, cleared land, or
construction sites. The waterways were clearly visible and surrounded by vegetation,

showing that there was little human encroachment at that time.

By 2014, noticeable changes had occurred. The red built-up areas expanded rapidly from the
northern section and began to spread toward the central and eastern parts of the LGA. This
expansion shows that urbanization was taking place at a fast pace, as more land was
converted for housing, roads, and other infrastructure. The once-large areas of vegetation
became fragmented and smaller in size, meaning that natural cover was being cleared to
make way for new development. Barren lands became more widespread, especially around
the edges of the growing built-up zones, possibly due to land clearing and construction work.
Waterways remained present, but it was evident that human activities were beginning to
approach their surroundings. This period marked a transition stage when Oredo started

moving from a semi-rural environment toward a more urbanized landscape.

The 2024 map presents a striking contrast compared to 2004. Built-up areas now dominate
much of the northern and central regions of the LGA, shows how much urbanization has
intensified over the years. Vegetation cover has reduced further, now mainly found in the
southern portion of the map where urban influence is less pronounced. The yellow patches of
barren land are more scattered throughout the area, reflecting ongoing development and land
modification. The waterways can still be seen, but their buffer zones appear narrower,
suggesting that urban growth has gradually encroached upon them. Overall, the 2024 map

represents a fully developed urban environment with limited natural cover remaining.
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4.2 Results of Accuracy Assessment

For the years 2004, 2014 and 2024 the Producer accuracy, User accuracy, Kappa coefficient

and Overall accuracy are shown below alongside their interpretations.

Table 4.1 confusion matrix for the year 2004

Classes Built up Bare Vegetation Water Total u
area ground ways
Built up area 6 0 0 0 6
Bare ground 2 8 0 0 10
Vegetation 0 0 55 0 55
Water ways 0 0 5 4 9
Total P 8 8 60 4 80
Note: U is user and P is producer
Table 4.2: Confusion matrix for the year 2014
Classes Built up Bare ground vegetation Water ways Total U
area
Built up 17 0 5 0 22
area
Bare ground 0 5 3 0 8
Vegetation 0 0 43 0 43
Water ways 0 1 0 6 7
Total P 17 6 51 6 80
Note that U is user and P is producer
Table 4:3 Confusion matrix for the year 2024
Classes Built up Bare Vegetation Water ways Total U
area ground
Built up area 35 0 2 0 37
Bare ground 0 8 7 0 15
Vegetation 0 4 41 0 45
Water ways 0 0 2 3
Total P 35 50 2 100

Note that U is user and P is producer
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Table 4.4: Result for Producer and User’s Accuracy

Year Accuracy Type Built-up area Bare ground Vegetation Water ways
(Y0) (Y0) (%) (Y0)
2004 Producer’s 100.00 80.00 85.71 100.00
Accuracy
User’s Accuracy  94.44 72.73 94.44 85.71
2014  Producer’s 100.00 83.33 84.31 100.00
Accuracy
User’s Accuracy  77.27 62.50 100.00 85.71
2024  Producer’s 100.00 61.54 82.00 100.00
Accuracy
User’s Accuracy  94.59 53.33 91.11 66.67

Table 4.5: Overall Accuracy and Kappa Coefficient

Year Overall Accuracy Kappa Coefficient
(OA %) (L)

2004 87.50 0.70

2014 88.75 0.73

2024 86.00 0.77

The accuracy assessment for the 2004, 2014, and 2024 LULC classifications indicates a high
level of reliability. The 2004 map achieved an overall accuracy of 87.50% with a Kappa
coefficient of 0.70, showing substantial agreement with the reference data. In 2014, the
overall accuracy slightly improved to 88.75% and the Kappa value increased to 0.73,
reflecting better classification consistency. By 2024, the overall accuracy was 86.00% with a
Kappa coefficient of 0.77, signifying strong agreement between the classified image and
ground truth. Across all years, built-up areas consistently recorded the highest accuracies,
while bare ground showed moderate results due to confusion with vegetation. Vegetation and
water bodies also maintained high classification reliability. Overall, all three maps exceeded
the 85% accuracy threshold recommended by the USGS, confirming that the classifications
are dependable for analyzing land use and urban growth patterns in Oredo Local Government

Area.
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4.3 Post classification analysis Results

Table 4.6: Comparison of Area Change from 2004-2024

2004 2014 2024
CLASS Area Area  Area Area Area Area
km % km % km %

Bare ground  29.9593447  12%  17.8465577 7%  42.21776859 17%
Built Up area 17.73827014 7% 7891136033 32% 94.29174097 38%
Vegetation 175.5559649 70%  140.5002687 56% 108.9454121 44%
Water ways ~ 27.05410885 11%  13.05807343 5%  4.862405718 2%

The built-up area in Oredo LGA showed a remarkable increase between 2004 and 2024,
clearly reflecting the rapid pace of urban growth and development. In 2004, built-up land
occupied only 17.74 km? (7%), but by 2014 it had expanded significantly to 78.91 km? (32%),
and by 2024, it further increased to 94.29 km? (38%). This sharp rise demonstrates the
growing population, demand for housing, and infrastructural expansion across the local

government area.

In contrast, vegetation cover experienced a continuous decline over the study period. From
175.56 km? (70%) in 2004, vegetation reduced to 140.50 km? (56%) in 2014 and further to
108.95 km? (44%) in 2024. This steady reduction shows the effect of human encroachment,
land conversion for building and agriculture, and the general loss of green areas due to
uncontrolled urbanization. The bare ground category fluctuated notably across the years,
dropping from 29.96 km? (12%) in 2004 to 17.85 km? (7%) in 2014, and later increasing
sharply to 42.22 km? (17%) by 2024. This change may be linked to temporary vegetation
regrowth in earlier years, followed by renewed land clearing and construction activities in
later periods. Water bodies also showed a significant reduction, decreasing from 27.05 km?

(11%) in 2004 to 13.06 km? (5%) in 2014, and further shrinking to 4.86 km? (2%) in 2024



4.4 The result of the evaluation of population density and growth patterns

Table 4.7: Projected Population of Oredo L.G.A (2006-2024)

Year t (Years after 2006) Projected Population (P)
2006 0 374,500
2014 8 468,620
2024 18 619,669

The population projection of Oredo Local Government Area between 2006 and 2024
demonstrates a consistent pattern of growth that directly influences land use dynamics within
the area. The bar chart shows that the population increased from 374,500 persons in 2006 to
468,620 in 2014, and further to 619,669 in 2024. This upward trend signifies continuous
urban expansion and population concentration, particularly around Benin City and its

surrounding communities.
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Figure 4.4 A Bar chart showing the projected population growth of Oredo Local Government
Area between 2006 and 2024
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Table 4.8: Projected population density of Oredo 2006 and 2024

Year Population Density (Persons/km?)
2006 1,504
2014 1,883
2024 2,488

The population density of Oredo Local Government Area shows a steady and significant
increase between 2006 and 2024. In 2006, the area recorded an estimated 1,504 persons per
square kilometer. By 2014, this value rose to 1,883 persons per square kilometer, and by
2024 it reached about 2,488 persons per square kilometer. This upward trend clearly
demonstrates a growing pressure on available land resources as the population expands. The
rise in density reflects continuous urban growth and increased demand for housing,
infrastructure, and social amenities within Oredo. Consequently, more land that was
previously used for vegetation or other non-urban purposes has likely been converted into
built-up areas to accommodate the expanding population. The pattern indicates that
population growth is a major driver of land use change and urban development intensity

across the study area.
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Figure 4.5 Bar chart showing the projected population density of Oredo Local Government
Area between 2006 and 2024.

4.5 The result of identification of areas where development within the study area;

The spatial pattern of development within Oredo Local Government Area reveals a clear
gradient in growth intensity across the region, indicating distinct zones of low, moderate, and
high development. The analysis of land use and land cover (LULC) data from 2004, 2014,
and 2024 demonstrates that urban expansion has been most pronounced around the central
urban core of Benin City, gradually decreasing towards the peripheral and rural areas of the

LGA.

Areas exhibiting high development intensity are predominantly located within the urban core
of Benin City, which includes neighborhoods such as Ring Road, Ugbowo, Siluko, Upper
Sakponba, and Sapele Road. These areas have experienced extensive urbanization driven by
population growth, commercial activities, and infrastructural development. The presence of
major road networks, higher accessibility, and concentration of economic and administrative
functions have contributed to rapid land conversion from vegetation and bare surfaces to
built-up areas. The density of structures and continuous spatial expansion in these zones

reflect advanced stages of urban development and intensive land use pressure.

40



Moderately developed areas are found around the urban periphery and transitional zones of
Oredo, including parts of Uselu, Aduwawa, Ikpoba Hill, and Egor boundary regions. These
locations represent semi-urban environments where land conversion is ongoing but less
intense compared to the city center. The development here is influenced by suburbanization
processes, as population spillover from the central areas encourages the establishment of
residential buildings, small-scale commercial enterprises, and service infrastructures. The
pattern of development in these areas suggests a gradual transformation from agricultural or

vegetative land to mixed urban land use.

Areas classified as low development zones are located at the outermost and rural fringes of
Oredo L.G.A, including settlements around Oko, Evbowe, and Ugbeka. These areas are
characterized by low population density, limited infrastructure, and predominance of
vegetation and agricultural land. Development in these regions remains minimal due to their
distance from the city center and limited accessibility. The persistence of natural and
undeveloped land cover in these areas contributes to the ecological balance and serves as

potential land reserves for future expansion.

In general, the distribution of development across Oredo L.G.A reflects the combined
influence of population growth, accessibility, and infrastructural availability. The observed
pattern ranging from high development intensity in the urban core to low intensity in the
peripheral rural areas highlights the progressive urban sprawl and land use transformation

within the study area over the twenty year period.
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CHAPTER FIVE
CONCLUSION AND RECOMMENDATION

5.1 CONCLUSION

Throughout the course of this study, extensive analyses were conducted to assess land use
and land cover (LULC) changes in Oredo Local Government Area using remote sensing and
Geographic Information System (GIS) techniques. By integrating multi-temporal Landsat
satellite images and geospatial analytical tools, the study successfully quantified the extent of
land cover transformations and examined the implications of these changes on urban growth
and planning within the study area. The analysis spanned three key temporal points 2004,
2014, and 2024 allowing for a comparative assessment of urban expansion, vegetation loss,

and land conversion trends over a twenty-year period.

The results of the LULC change detection analysis revealed significant spatial and temporal
transformations in Oredo. One of the most striking findings was the continuous increase in
built-up areas over the years, indicating accelerated urbanization driven by population growth
and infrastructural development. Between 2004 and 2024, built-up areas expanded
dramatically, often replacing vegetation and bare land. The 2014-2024 period showed the
highest rate of land conversion, highlighting intensified development activities and growing
settlement pressure within the urban core of Benin City. Conversely, vegetation cover
exhibited a consistent decline throughout the study period, reflecting the impacts of human
encroachment, deforestation, and urban sprawl. Similarly, water bodies and bare lands
decreased in extent, signifying environmental changes linked to land reclamation and

construction activities.

The population projection and density analysis supported these findings, showing a sharp

increase in population density from approximately 1,504 persons per square kilometer in
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2006 to about 2,488 persons per square kilometer in 2024. This growth emphasizes the close
relationship between demographic expansion and land use transformation in Oredo. Areas
within the city center, such as Ring Road, Ugbowo, and Sapele Road, were identified as
zones of high development intensity, while peripheral areas like Oko and Ugbeka exhibited

low levels of development.

Overall, the integration of remote sensing and GIS proved to be an effective approach for
monitoring spatial development and understanding urban dynamics within Oredo L.G.A. The
study demonstrated how geospatial technologies can serve as valuable tools for urban
planners and policymakers in managing land use changes, predicting growth patterns, and
promoting sustainable development. The findings underscore the urgent need for proactive
urban planning strategies that balance physical development with environmental preservation

to ensure orderly and sustainable urban growth in Oredo.

5.2 RECOMMENDATION

Based on the findings and analyses of this study, several key recommendations are proposed
to enhance effective urban planning and sustainable land management in Oredo Local
Government Area. There is an urgent need to establish an efficient and up-to-date urban land
use management system that integrates Geographic Information System (GIS) and remote
sensing technologies. Such integration will enable continuous monitoring of land cover
changes, detection of informal settlements, and early identification of areas experiencing

uncontrolled urban expansion, thereby improving decision-making and urban governance.

Urban authorities should develop a comprehensive master plan that aligns with the spatial
realities revealed in this research. This plan should include clear zoning regulations that
separate residential, commercial, industrial, and green areas to control urban sprawl,

minimize land use conflicts, and preserve vegetation and water bodies. Environmental
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sustainability should also be central to future development policies through initiatives such as

reforestation, urban greening, and enforcement of environmental protection laws.

Population growth management must be incorporated into planning strategies to address the
rising population density in Oredo. This includes improving infrastructure, housing, water
supply, transportation, and waste management systems to maintain a livable and functional
urban environment. In addition, strengthening institutional capacity through training
programs for planners and GIS professionals, along with public awareness campaigns, will

promote compliance with planning regulations and environmental protection practices.

Overall, sustainable urban planning in Oredo requires the combination of modern geospatial
technologies, sound policy implementation, and community participation. Adopting these
strategies will ensure that urban growth in the area remains balanced, inclusive, and

environmentally sustainable.
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